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Abstract 

The HVRC VRdose software comprises of a pair of tools: 

• HVRC VRdose Planner: A tool for simulating work scenarios, with radiation 

visualisation and dose-rate charts for scenario participants 

• HVRC VRdose Briefer: A tool for playback of scenarios created using the HVRC 

VRdose Planner, for training/briefing purposes 

This document is the software user manual for the HVRC VRdose Planner software. It 

provides an overview of the system concept and workflow, as well as reference information 

for users. 
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1. INTRODUCTION 

1.1 The HVRC VRdose Planner 

The HVRC VRdose Planner is a real-time software tool for modelling radiological 

environments, planning a sequence of activities in the modelled environment, optimising 

protection against radiation, and producing job plan reports with dose estimates. The HVRC 

VRdose Planner offers the possibility to refine the radiological model to improve the accuracy 

of estimates and configure the dosimetric output provided. The software can also be used as 

an aid to producing post-work review reports, with real measurements included. Furthermore, 

the software provides support for presenting information to different types of users for briefing 

and decision-making, thus serving as an aid to communication between stakeholders in an 

intervention. 

1.2 Intended readership 

The audience for the software user manual is the end-users of the HVRC VRdose software. 

1.3 Applicability statement 

This issue of the user manual applies to version 2.0 of the HVRC VRdose software. 

1.4 Purpose 

This document is the software user manual for the HVRC VRdose Planner. It introduces the 

software and its intended usage, and provides useful reference material for advanced users. 

Additional information about specific features of the system is available via an online help 

system. 

1.5 How to use this document 

This document should be used as a guide to the HVRC VRdose system concept and 

installation of the software. It also contains some important reference information. 

It is intended to provide a general understanding of the capabilities of the software how these 

capabilities can be accessed. 

The Concept and Overview sections describe the general processes and principles supported 

by the software and the workflow and functionality that the software supports  

The Getting Started section explains how to install the software and start using it. 

The Reference section provides an overview of main menus and explains configuration 

options accessible via the user preferences interface. It also provides guidance on preparing 

3D models for use in the system and on system administration tasks, including updating the 

software and taking backups of databases. 

A glossary is provided in the appendices, along with a description of the file formats used for 

importing dose-rate measurements and externally produced dose maps. 
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1.6 Related documents 
 

ICRP 60 1990 Recommendations of the International Commission on 
Radiological Protection. ICRP. Publication 60. Ann. ICRP 21 (1–3), 
1991. 

ICRP 101 Assessing dose of the representative person for the purpose of 
radiation protection of the public and the optimisation of radiological 
protection: Broadening the process (ICRP Publication 101). Ann. 
ICRP 36 (3), 2006. 

ICRP 103 The 2007 Recommendations of the International Commission on 
Radiological Protection (ICRP Publication 103). Ann. ICRP 37 (2-4), 
2008. 

HWR-896  Comparative Study of Radiation Visualisation Techniques for 
Interactive 3D Software Applications (HWR-896), OECD Halden 
Reactor Project, Louka, M. N., et al., 2011. 

HWR-982 A Study of Outage Planning under Complex Radiological Conditions 
using Halden Planner (HWR-982), OECD Halden Reactor Project, 
Vabø, R., et al. 2011. 

HWR-979 Comparative Study of Radiation Visualisation Techniques for 
Interactive 3D Software Applications (follow-up study) (HWR-979), 
OECD Halden Reactor Project, Louka, M. N., et al., 2011. 

HWR-999 Characterization Implemented in a Virtual Environment (HWR-999), 
OECD Halden Reactor Project, Vabø, R., et al. 2011. 

HWR-1030 New Computational Model for Areal and Personal Monitoring in 
Nuclear Environments (HWR-1030), OECD Halden Reactor Project, 
Szőke, I., 2012. 

HP-Benchmark Benchmark test results for validation of the Basic Point Kernel and 
the Extended Point Kernel dosimetric code units of the Halden 
Planner, OECD Halden Reactor Project, Szőke, I. et al., 2012. 

ISO/IEC 14772-1 Virtual Reality Modelling Language Specification, 1997. Available 
online on the Web3D Consortium website at http://www.web3d.org/. 

1.7 Conventions 

File paths, contents of data files, and code are shown using the Courier font – e.g. 

c:\planner\examples\model\model.wrl 

The convention “Menu Name > Menu Item” is used to indicate a menu selection from the 

application’s main menu bar. 

Keyboard shortcuts are described as “Command-<Key>” – e.g. “Command-X”. 

The command key used for keyboard shortcuts depends on the host platform. For example, 

the ctrl-key is used on Windows and the cmd-key is used on macOS. The correct command 

key for shortcuts is always indicated in the menus next to the menu item that the shortcut 

controls. 

Distance units are by default in metres. The Y-axis is up in the 3D coordinate system used by 

the HVRC VRdose Planner. 

1.8 Problem reporting instructions 

Please send questions, bug reports, or requests for new features to: vrdose-support@ife.no  

http://www.web3d.org/
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When submitting bug reports, please include the following information: 

• A description of the result and how it differed from what you expected. 

• The conditions or circumstances under which the problem occurred. 

• Any other information that could be useful to isolate the problem. 

When sending bug reports, please include (if possible) a copy of the technical details in the 

about box (use the save button in the 'About' window to save it to file). The about box can be 

accessed via the Help menu. 
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2. Concept 

A significant motivation behind the HVRC VRdose Planner has been to make advanced, 

radiation exposure situation analysis technology accessible to a broader range of users, who 

can benefit from an interactive 3D visual representation of radiation risks to support ALARA 

optimisation. By integrating radiological information with 3D models of nuclear facilities and 

environments, to facilitate risk-informed planning and work execution, we aim to support the 

optimisation of radiological protection for activities in nuclear environments and enhance 

safety culture, by increasing stakeholders’ comprehension of radiation risks, thus contributing 

to improving safety in nuclear facilities. 

2.1 Introduction 

The purpose of this chapter is to provide a brief introduction to the recommendations for 

radiological protection published by the International Commission on Radiological Protection 

(ICRP) in “ICRP 103”. The principles and recommendations of the ICRP are important 

because they serve as the basis for national regulations related to activities in exposure 

situations, and represent current best practice for radiological protection planning. They are 

therefore reflected in the design, terminology, and evolution of the HVRC VRdose Planner 

software, and are thus important to understanding the HVRC VRdose Planner. 

The key concept in the field of radiological protection, which has been refined over many 

years, is that of ALARA (“As Low As Reasonably Achievable”). The goal of radiological 

protection planning is to optimise the level of risk, by minimising the dose, to achieve a level 

that is acceptable to the stakeholders involved. The word “reasonable” is the key here, as the 

goal is not to aim for the lowest dose for each individual involved in an exposure situation 

regardless of social or economic aspects. To explain what this means in practice, the ICRP 

has developed three key principles, which are described below, and makes recommendations 

within the framework of these principles on how they should be applied. 

2.2 Radiological Protection Principles 

ICRP 60 (published in 1991) introduced three fundamental principles for radiological 

protection: 

• Principle of Justification 

• Principle of Optimisation of Protection 

• Principle of Application of Dose Limits 

While these principles are retained in ICRP 103, the latter publication provides revised 

recommendations on how these principles should be applied. Before explaining each of the 

principles, and outlining some of the recommendations of ICRP 103, it is necessary to note 

that all three principles apply only for planned exposure situations. For emergency exposure 

and existing exposure situations, only the first two principles apply. Except for during (or after) 

an accident situation, radiological protection activities related to a nuclear power plant, for 

example, fall into the category of planned exposure and it is for ALARA planning of planned, 

occupational, exposure that the HVRC VRdose Planner is primarily targeted, although it 

would also be a useful tool to support decision-making in emergency or planning activities in 

existing exposure situations too. 

To clarify, ICRP 103 defines three exposure situations that are intended to cover all types of 

exposure situations that can arise. 
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• Planned exposure situations are those involving the “planned introduction and 

operation of sources”.  

• Emergency exposure situations are “unexpected situations such as those that may 

occur during the operation of a planned situation, or from a malicious act, requiring 

urgent attention”. 

• Existing exposure situations are “exposure situations that already exist when a 

decision on control has to be taken”. This typically means situations with significant 

natural background radiation, but also includes situations resulting from past 

accidents or other activities such as weapons testing. 

In addition to occupational exposure to workers, ICRP 103 recognises public exposure and 

medical exposure as distinct exposure types. The term potential exposure is used to describe 

exposure that is anticipated but not intended in a planned exposure situation. Potential 

exposure, therefore, describes the exposure that would be received if a planned job goes 

wrong. The risk of potential exposure should be minimised when producing a plan for 

acceptable exposure to execute a planned activity. Of course, organisations should strive to 

understand the causes of potential exposure actually received when a job is done, and 

communicate lessons learnt that could contribute to reducing the risk of potential exposure 

when executing similar activities in future. 

2.2.1 Principle of Justification 

“Any decision that alters the radiation exposure situation should do more good than harm” 

(ICRP 60). 

This principle implies that the decision-making process should include an evaluation of 

whether the net benefit of a change to an exposure situation is positive. The benefits that 

should outweigh the detriment may be individual or societal. The detrimental risk of radiation 

exposure may be a small part of the overall equation to determine if the new situation is 

positive. 

2.2.2 Principle of Optimisation of Protection 

“The likelihood of incurring exposures, the number of people exposed, and the magnitude of 

their individual doses should all be kept as low as reasonably achievable, taking into account 

economic and societal factors” (ICRP 60). 

Given that a situation is justified, we should aim to minimise individual doses, but in such a 

way that we also minimise the number of individuals exposed, following the principle of 

ALARA. So within dose limit restrictions applied to individuals, we should aim to discover the 

best, reasonable, level of protection for the individuals that will be exposed. The HVRC 

VRdose Planner is intended to provide support in the process of identifying the optimal 

solution for protection for planned exposure, and to identify risks of potential exposure that the 

stakeholders need to be made aware of to reduce the risk of actually receiving higher doses 

than planned. 

2.2.3 Principle of Application of Dose Limits 

“The total dose to any individual from regulated sources in planned exposure situations other 

than medical exposure of patients should not exceed the appropriate limits specified by the 

Commission” (ICRP 60). 
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National laws and regulations on the application of dose limits are generally based on ICRP 

recommendations. The limits specified by ICRP 103 are primarily intended to guide the 

application of the optimisation of protection principle 

2.3 Recommendations on Applying Radiological 
Protection Principles 

2.3.1 Recommendations on Justification  

Within the scope of the HVRC VRdose Planner, radiation protection staff in collaboration with 

other stakeholders would normally be responsible for justifying a job involving operational 

exposure, however this is formally within the scope of a high level justification for the 

operation and maintenance of the facility in which the work will take place, so may not need to 

be explicitly stated in the preparation of a work permit request, for example. When justifying 

the introduction of an entirely new facility, the responsibility for justification generally lies with 

governments and national authorities. As this principle extends beyond the responsibility of 

radiation protection authorities, the ICRP provides only limited guidance on application of the 

principle beyond acknowledging that different approaches can be taken for occupational and 

public exposure depending on whether planned actions can be taken on the source or 

whether it is only possible to modify pathways of exposure, typically in an emergency or 

existing exposure situation.  

2.3.2 Recommendations on Optimisation of Protection 

ICRP 103 provides a general overview of recommendations on optimisation of radiological 

protection, noting that earlier recommendations continue to apply.  The latest detailed 

guidance from the ICRP can be found in ICRP 101, published in 2005, which focuses on dose 

assessment issue and the optimisation process. As for ICRP 103, ICRP 101 builds on ICRP 

60.  

In order to minimise dose, we need to optimise time, distance and shielding, while taking into 

account other constraints used to determine the scope within which the dose can be justified 

as reasonably low, such as acceptable risk of potential exposure, and other risks and costs. 

In addition to restricting the individual dose or risk to a worker, the size of the collective dose 

to all workers involved in a job is also an important parameter that is taken into account in 

selecting the best of multiple options. 

The optimisation process itself is generally iterative and is focussed on planning ahead. While 

we are, of course, interested in evaluating performance, to learn from it after a job has been 

done, optimisation is focussed on minimising risk for planned activities. Effective optimisation 

in practice requires that stakeholders have a common understanding of the basic principles of 

radiological protection and that an active safety culture, and learning from past experience, is 

encouraged. 

The steps of the iterative optimisation process given in ICRP 103 are illustrated in the figure 

below: 
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Considerations to minimise dose in order to identify possible protection options include: 

• Less Time → Less Dose 

• More distance→ Less Dose 

• More shielding → Less Dose 

• More shielding → More Time → More Dose… 

Effective planning can reduce the time taken to carry out an activity, thus reducing dose. 

Distance to sources can also be improved through effective briefing of workers and 

encouragement of a radiation safety mind-set to ensure that workers take breaks in lower 

dose areas of the work area and move away from sources when carrying out activities that do 

not require them to be close to a source. 

Use of temporary shielding must be justified – is it necessary to comply with the Principle of 

Application of Dose Limits? If it is not necessary to prevent violation of dose limits, will it 

contribute to reducing the collective dose of the stakeholder workers, including radiation 

protection (RP) workers, for the entire planned activity? We should also bear in mind that 

installation, movement or removal of temporary shielding itself requires spending time in 

areas of elevated radiation, is normally only allowed to be done with authorisation from 

responsible RP staff, and planned changes to the exposure situation will often trigger a 

requirement for control measurements of dose-rate levels, which may significantly increase 

the time taken to complete a job. Tools such as the HVRC VRdose Planner should be useful 

for modelling alternative scenarios in order to determine which would give the best result, and 

also be helpful when briefing workers and documenting why the selected solution is 

considered optimal.  

The best option is not always the one that will give the lowest dose. For example, the option 

that gives lowest planned dose exposure may involve significantly higher risk for potential 

exposure, fire, flooding, or some other detrimental result. The lowest dose option might also 

Evaluate the exposure 
situation, including any 

potential exposure

Select an appropriate 
value for the constraint 

or reference level of 
dose

Identify the possible 
protection options

Select the best option 
under the prevailing 

circumstance

Implement the 
protection option

Figure 2.1 ICRP 103 Iterative optimisation process 
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involve a greater risk of the operation taking significantly longer than planned, again giving 

increased risk for additional exposure; taking into account the likelihood of receiving greater 

dose than planned, and the amount of additional dose in that case, what might first appear to 

be the best option may not be.  

2.3.3 Recommendations on Application of Dose Limits 

Dose limits are essential to managing the individual health risk to individual workers and are 

to be treated as absolute constraints on the dose received for planned exposure situations. 

While many factors can contribute to determining what is reasonable in ALARA, when 

selecting between alternative optimisation plans, the dose limits provide a ceiling for what is 

an acceptable dose over time. Intentionally breaching the limits is unacceptable and any 

breach would normally need to be reported to national regulators, and depending on the 

severity of the breach may have disciplinary consequences for those responsible within the 

frame of national health and safety laws. Occupational dose limits are significantly lower for 

pregnant women than other workers, and occupational exposure in aviation and space are 

also treated as special cases by the ICRP. 

Looking at exposure limits only (i.e. not including organ limits) for workers. The ICRP 103 

recommended limits for occupational dose are: 

• 20 mSv/year averaged over 5 years 

• 50 mSv/year in any year 

• 100 mSv total in 5 years 

Related to the dose limits is the dose constraint, which is used to guide the optimisation of 

occupational exposure situations (and public exposure) within the scope of a single planned 

operation. In an emergency or existing exposure situation the so-called reference level is 

used as the upper limit of dose or risk that an individual could be allowed to receive as part of 

a planned action. The value to use depends on the exposure circumstances. For planned 

activities in exposure situations with levels close to the reference value, protective measures 

would be required. The residual dose is the dose expected after protective measures have 

been implemented, which would contribute to an individual worker’s occupational dose. 

Note that emergency preparedness should include planning for emergency response, where 

reference levels are used. Emergency exposure may be permitted (assuming that it is not 

unavoidable) to exceed the maximum reference level value (100mSv) on a voluntary basis in 

extreme circumstances only, to save a human life or prevent a disaster – no other 

circumstance are considered justifiable. 

2.4 National Regulations 

National regulations on dose limits and radiological protection principle are generally aligned 

with ICRP recommendations, however national guidelines on the practical application of the 

principles vary, and individual utilities may also have stricter reporting and documentation 

requirements than regulators require, hence a software tool to support ALARA planning 

internationally should ideally aim to be flexible enough to be easily adapted to support 

established practices, systems and procedures. 

An easily accessible example of national regulations and guidelines can be found in the 

combination of the US NRC 10 CFR Part 20 (and Part 50) and the US Department of Energy 

Radiological Control Manual. The OECD NEA has published two interesting reports that 

provide an overview of current challenges and practices, including surveys of national 
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regulations and practices. The first of these is focussed on radiation protection optimisation, 

and was produced as input to the ICRP during the development of the ICRP 103 report, while 

the second focuses on work management aspects. 

See for example: 

• OECD NEA (2005) Optimisation in Operational Radiological Protection (NEA Report 

5411), ISBN 92-64-01050-5. Report by the Working Group on Operational 

Radiological Protection of the Information System on Occupational Exposure. Online, 

URL http://www.oecd-nea.org/html/rp/reports/2005/nea5411-optimisation.pdf 

(checked 2017.03.06). 

• OECD NEA (2009) Work Management to Optimise Occupational Radiological 

Protection at Nuclear Power Plants (NEA Report 6399), ISBN 978-92-64-99089-0. 

Online, URL http://www.oecd-nea.org/html/rp/reports/2009/nea6399-

WorkManagement.pdf (checked 2017.03.06). 

• US DOE (1994) Department of Energy Radiological Control Manual, DOE/EH-0256T. 

Online, URL https://www.osti.gov/scitech/biblio/10143998-X3KRUj/native/ (checked 

2017.03.06). 

• US NRC (1991, 2007) Standards for Protection Against Ionizing Radiation, NUREG 

10 CFR Part 20, Revision 72 FR 55921, 2007. Online, URL 

http://www.nrc.gov/reading-rm/doc-collections/cfr/part020/full-text.html (checked 

2017.03.06). 

  

http://www.oecd-nea.org/html/rp/reports/2005/nea5411-optimisation.pdf
http://www.oecd-nea.org/html/rp/reports/2009/nea6399-WorkManagement.pdf
http://www.oecd-nea.org/html/rp/reports/2009/nea6399-WorkManagement.pdf
https://www.osti.gov/scitech/biblio/10143998-X3KRUj/native/
http://www.nrc.gov/reading-rm/doc-collections/cfr/part020/full-text.html
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3. Overview 

3.1 System Overview 

The HVRC VRdose Planner is a tool for modelling radiological conditions, planning a 

sequence of activities in the modelled environment, and producing job plan reports with dose 

estimates. The software can also be used as an aid to producing post-work review reports, 

with the possibility to refine the radiological model to improve the accuracy of estimates. 

Furthermore, the software provides support for presenting information to different types of 

users for briefing and decision-making, thus serving as an aid to communication between 

stakeholders in an intervention. 

3.2 Applications 

The HVRC VRdose Planner is primarily intended to support radiological protection planning, 

and optimisation of protection within dose constraints for planned activities. 

Specifically, it can be used for 

• Preparation for jobs in radiological environments 

• Preparation of work permit requests and preparation of radiological work permits 

• Briefing of staff, contractors, and other stakeholders 

• Post-job analysis and reporting 

• Education and training in radiation protection and ALARA mind-set 

• Testing and visually assessing the results of new dose calculation models 

3.3 Key Features 

The HVRC VRdose Planner supports near real-time calculation of shielding effects, doses, 

and relative contributions to dose by different isotopes, enabling the rapid evaluation of 

alternative protection optimisation or maintenance procedure scenarios. To support the user 

in interpreting the results of calculations, the HVRC VRdose Planner provides charts, graphs, 

and 3D radiation visualisation, updated immediately to reflect any changes to the modelled 

radiological condition, such as changing shielding materials, and human activities over time. 

Overview of key features: 

• Supports modelling of radiological conditions 

• Supports real-time calculation of shielding effects, doses, and relative contributions to 

dose by different isotopes, enabling the rapid evaluation of alternative job scenarios 

• Provides visualisation of potential hazards to support risk-informed decision making 

• Supports users in following existing job planning procedures and fulfilling reporting 

requirements 

• Can be interfaced with alternative dosimetry models and calculation codes 

Alternative calculation software modules can be used if they can provide appropriate input 

data and are interfaced using a supplied SDK. This functionality enables the use of 

calculation methods other than those supplied, and offers a convenient technology for 

comparing of dose estimates produced using different calculation methods. This enables the 

software to leverage existing, qualified, calculation methods, and to be used to support the 

development and testing of new calculation codes. 
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3.4 System Users 
 

The HVRC VRdose Planner is aimed at three main classes of end-user: 

Radiation Protection use the software to model radiological conditions, optimise the 

placement of shielding to support work in specific areas of a nuclear 

facility, and evaluate the radiological consequences of the existence 

of different isotopes in a nuclear facility over time. Also use 

measured dose-rate values as an aid to modelling radiological 

conditions as accurately as possible. 

Engineering uses the software to produce pre-job work descriptions for planned 

work with descriptions of activities and estimated durations. Use the 

software to optimise routes, work locations, waiting locations. 

Provide feedback to Radiation protection if necessary. Also use the 

software to support the production of post-work experience review 

reports. 

Instructors use the software to communicate radiological conditions or a job 

description to staff or students. Instructors may have either (or both) 

a work planning or radiation protection background. 

Radiation Protection and Engineering staff would normally collaborate to agree on the area in 

which work will take place and to optimise the positioning of shielding and other 

countermeasures related to the radiation exposure situation. More information on the tasks 

that the HVRC VRdose Planner supports within a typical workflow is provided later in this 

chapter. 

3.5 System Overview 

The software system comprises of the following main components 

• HVRC VRdose Planner: Main tool with 3D workspace used to add, access, and 

manipulate data in the database, and produce reports 

• HVRC VRdose Briefer: A dedicated 3D viewer for presenting scenarios prepared 

using the HVRC VRdose Planner in briefing situations 

• An integrated database, in which data used by the Planner and Briefer is stored 

Data is typically imported into the software from files and/or other databases, and include: 

• Detailed 3D geometry to visualise a nuclear facility or environment 

• 3D geometry representing tools and equipment required to carry out a job 

• Isotopic characterisation of sources (historical data, recent surveys, etc.) 

• Dose-rate maps (if an external dose modelling system is used to produce dose maps) 

• Actual dose-rate measurements  

The HVRC VRdose Planner can be used to produce: 

• Scenarios with job activities and trajectories that can be replayed as animations 

• Dose graphs per worker or dosimeter in a scenario 

• Pre-job work reports with a description of a scenario and the associated dose 

predictions 

• Post-job experience review report given the entering of measurement data made 

when a scheduled job described in a scenario was actually carried out. 
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In order to define radiological layouts and job scenarios, information is imported from files, 

entered interactively through direct manipulation of 2D UI components or 3D objects using a 

mouse, or filling in forms with a keyboard. The user is supported in decision-making and 

evaluation of alternative scenarios through 2D charts and graphs and 3D plots of radiological 

conditions. Data entered is stored in a database and subsequent planning activities are thus 

able to use radiological conditions modelled previously, or expected as the result of planned 

work that is scheduled, as the starting point for planning further activities. Historical data for 

jobs that have been completed is available for use by instructors to support the training of 

staff, learning from past experience, while team leaders can brief workers on planned 

activities. The combination of graphs, 3D visualisation, and animation of planned work 

sequences make this a powerful communication aid. 

Most data provided to model radiological conditions and to simulate job scenarios are entered 

interactively using an interactive 3D workspace. Objects in a layout and participants in a 

scenario are introduced to the workspace using a 3D drag and drop user interface, and some 

objects have parameters that can be manipulated directly or by entering values. In order to 

convey a sense of the dimensions of the layout and objects modelled, the user can display a 

grid with user-configurable spacing and also display the dimensions of selected objects, 

including routes/trajectories for objects or workers that move during a scenario. Free camera 

navigation is supported to enable the user to position a virtual camera, and target based 

travel techniques, including pre-defined and custom viewpoints and “go to selection” are 

supported. 

3.6 3D Geometry Data Management 

While the HVRC VRdose Planner can be used to model simple scenes using an empty floor 

situation to which source and shielding are added, detailed 3D models are normally added to 

the system database in a geometry interchange format. In the first version of the HVRC 

VRdose Planner, only the ISO VRML97 geometry data format was supported for importing 

models to the Model Bank. Most CAD systems are capable of exporting 3D models in ISO 

VRML97 format, and third party geometry conversion tools and services are available for 

CAD systems that do not support direct export in this format. In version 2.0, models can also 

be imported in the newer ISO COLLADA/DAE format. 

In the Model Bank, we distinguish between Rooms (e.g. the nuclear facility itself) and 3D 

models that can be added to a layout by the user as part of a scenario, such as tools and 

equipment needed to perform a job. Rooms can be date-tagged in the Model Bank, so the 

system can determine which of multiple versions of a plant model to use depending on the 

date associated with a scenario and the date of a model version. In theory, this makes it 

relatively easy to integrate existing 3D plant databases by importing date-specific plant 

models as “Rooms” into the HVRC VRdose Planner. 

3.7 Radiation Visualisation 

Given a set of sources and a shielding configuration, or a set of pre-calculated dose maps, 

the system enables the user to toggle a 3D visualisation of the radiological conditions in order 

to support decision-making about the form of the radiological situation. 

Several 2D and 3D visualisation techniques are offered that can be user-configured and 

combined, with a set of default configuration provided based on the results of usability 

studies. The visualisations are colour coded and the user can select between user-
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configurable sets of colours, which map radiation levels to colours. The software supports 

switching between visualisation configurations and colour sets on the fly. 

Examples of the kinds of 3D visualisation techniques supported by the software are illustrated 

below. For volumetric rendering techniques such as the "isosurfaces", it is usually helpful to 

turn on value-dependent transparency, so that the shape of the highest dose levels is more 

easily visible through the lower levels. A perceptual colour map (based on a blue to yellow 

heat scale) selected (Figure 3.1, Figure 3.2, Figure 3.3, Figure 3.4, Figure 3.5). 

 

 

 

Figure 3.1 Point cloud with Density Proportional to Radioactivity Level. 

Figure 3.2 2D slice cross-section of 3D data. 



HVRC VRdose Planner SUM Issue 2 Revision 1 (4 November 2020) 
Software User Manual 

 

- 14 - 

 

 

 

 

 

Figure 3.3 Scalar field comprising of a grid of boxes. 

Figure 3.4 Volumetric visualisation technique. 

Figure 3.5 View Dependent smooth isosurfaces in combination with a point 
cloud, showing the boundary between the radiation level at the current location 
and the next level. 
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3.8 Workflow 

In this section, an overview of the general radiological protection planning, optimisation and 

monitoring workflow supported by HVRC VRdose is presented. The following sections briefly 

explain how HVRC VRdose supports each of the activities illustrated.  

 

 

When planning a job in a radiological complex situation, we need to be able to transfer 

information between each planning activity and to explain how that is done we must introduce 

a handful of concepts that are used to manage the information flow in the workflow (Figure 

3.6). The following concepts are referred to frequently in the sections that follow, and in some 

cases more detailed explanations are provided later: 

• Scenario: A collection of participants that perform actions over time in a room. A 

scenario always has a specified start and end date, and a status (draft, scheduled, 

completed etc.) 

• Participant. An object that can be added to a room, thus participating in a scenario 

• Room: A virtual environment in which a scenario takes place. It is typically 

represented as a single static 3d model representing a building. While static within 

the scope of a single scenario, there may be multiple variants of a room model 

representing the (planned or actual) state of the building at specific dates/times 

• Layout: A static representation of the virtual radiological environment that represents 

a snapshot at a specific time that can be used as a reference scene configuration for 

new scenarios. Typically comprises of room + sources + shielding, but sometime 

other equipment left as the end state of a related job (e.g. a job is spread over several 

days represented by separate scenarios) 

• Project is a collection of related scenarios and layouts, with additional common 

project meta-data (expected start date, expected end date, description, references) 

These and other definitions can also be found in the appendix. 

  

Characterise  
& Model 

Environment

Plan Work 
Procedure

Review & 
Schedule

Brief Execute
Evaluate & 

Report

Figure 3.6 Workflow Diagram 
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3.9 Supporting Characterisation and Modelling the 
Environment 

A layout can contain known radionuclide sources, which can have different shapes or forms. 

In the current version of the HVRC VRdose Planner, sources can have the forms of lines, 

points, quads, or closed volumetric meshes.  

The radionuclides supported by the included calculators include 60Co, 58Co, 110mAg, 

137Cs, although two of the calculators include additional radionuclides. Sources have a date 

associated with the values of the properties that describe its character. This enables the 

software to consider decay, using a simplistic model based on half-life over time.  

Shielding can be introduced into a layout, and be moved as part of a work scenario. At 

present, shield composition is limited to iron, lead, water, concrete and sand. Rectangular, 

cylindrical, and volumetric mesh shield geometry are supported with user-configurable 

dimensions. 

3.9.1 Measured Dose-rate Data 

Measured dose-rate measurements associated with specific dates and times collected during 

a radiological survey can be stored in the database, and are useful as an aid to 

characterisation, planning and review. These measurements can be visualised with colour-

coded values at the location of the measurement within a user-configured timeframe relative 

to the “current scenario time” in a scenario, to see the most recent measurements relative to 

the planned time of a scenario. If a layout contains sources or a dose map then you can also 

access a table of showing the estimated value (at scenario time) at each measurement 

location, the measured value, and the %deviation (+/-). 

3.9.2 Radiation and Dose Calculation 

The HVRC VRdose Planner is supplied with three calculators. Two of these are point-kernel 

based calculators for estimating the dose, isotopic contribution to dose, and shielding effects, 

while the third is a pseudo-calculator that does not compute dose maps itself but uses data 

from imported dose maps to estimate the dose at any location within the dose mapped space. 

By default, we expect users to use the supplied point-kernel calculators for most planning and 

optimisation purposes, but with the option to import data from other offline calculators for 

plans that are to be scheduled, typically because the offline calculator has been qualified for 

use or because more complex methods (such as monte-carlo simulation) are required by 

company or national regulations. 

The supplied point-kernel calculators have the advantage of being reasonably accurate and 

being able to cope well with dynamically changing situations with close to real-time response. 

Changes to sources and shielding conditions or properties trigger an immediate update of the 

radiological situations, and any associated visualisations. The HVRC VRdose Planner 

calculates accumulated dose equivalents for virtual dosimeters using either real-time or pre-

calculated dose-map data as basis for calculations. 

Both point-kernel (pk) calculators are documented in detail in a Halden Work Report (HWR-

1030), available to HVRC VRdose Planner users on request. A benchmark comparison 

between results from the supplied calculators and reference calculations is provided in the 

HVRC VRdose Planner system documentation. The two pk-calculators are labelled basic and 

extended, where the basic model is relatively simple and very fast, but not applicable to all 
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situations, while the extended calculator is significantly more accurate in a much broader 

range of situations, but is also significantly slower. In comparison with monte-carlo based 

methods, it is unfair to describe either method as slow, as the difference between the two pk-

calculators is essentially a question of how many re-computations we can achieve per second 

while multiple sources or shields are moving. 

3.10 Supporting Work Procedure Planning 

3.10.1 Scenarios 

The fundamental building block for the simulation of a work procedure in the HVRC VRdose 

Planner is the scenario. A scenario comprises of a set of participants that perform actions in a 

sequence in a room  

• Room: The modelled space in which a job takes place – typically a model of part of a 

nuclear facility. Although the model may change over time (especially in a 

decommissioning setting), it is generally static within the scope of a single job. 

• Participants: manikins or other objects, such as tools, sources, shields, vehicles 

• Actions: walking, lying down, crouching, waiting, working, etc. 

Actions take place on a trajectory or path through the room and represent a participant’s 

position in the scene at a specific time as dictated by a participant’s actions. Sets of actions 

can be grouped as steps with a description entered by the user, thus enabling the 

organisation of sets of actions into a work plan. Steps can reference standardised procedures 

that specify in detail how a specific work task should be done but the details of that are not 

usually modelled in the HVRC VRdose Planner, where the focus is primarily on where a task 

is done and for how long rather than on producing a detailed animation of the micro-actions of 

the procedure itself. For example, a work step might be “remove the screws using a 

screwdriver”, where the user is simply “working” (action) for an estimated duration of time at a 

specified location using the object screwdriver. 

A visual timeline provides an overview of a scenario, listing participants and showing a 

schedule of actions and a visual representation of the work plan is also provided to enable the 

easy grouping of actions into work steps. 

3.10.2 Radiological Environment Analysis 

The radiation visualisation capabilities of the system are very useful for rapidly identifying 

optimal wait areas or areas to avoid unless absolutely necessary. For any scenario, the 

expected total dose per worker, collective dose, and maximum and minimum dose are also 

readily available to the user, but a number of additional features are also provided to assist in 

the optimisation of shielding.  

For example, you can: 

• Display the collective dose history for all virtual dosimeters for the time interval 

represented by the scenario, or for a single selected virtual dosimeter 

• Display shielding effects information per virtual dosimeter for the radiological situation 

at the current scenario time 

• Display the per isotope contribution to dose-rate per virtual dosimeter 
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The second two examples above are only available if using a calculator that supports the 

provision of this information (e.g. in the standard package, this data is not available if 

imported dose maps are used instead of one of the two point-kernel calculators). 

3.11 Supporting Review and Scheduling Process 

An Annotation Manager function supports adding feedback and comments to a scenario. 

Annotations are also used to highlight key things in a scenario, such as hazards, access 

ways, that can be displayed during a briefing session, and are required for pre-job reporting. 

The annotation manager can also be used to handle checklists. 

It is possible to compare the “vital statistics” of scenarios in the database, such as the 

duration, max/min dose-rate, accumulated dose, etc., which is useful for quickly comparing 

alternative plans, or comparing a proposed plan with a similar “historic” scenario that has 

been completed in the past. This information is provided in both tabular and graphic form and 

can be exported as a report from the system. The table itself can also be exported as raw 

data for use in spreadsheet or statistical software. 

3.11.1 Pre-Job Work Plan Reports 

Pre-job work plan reports can be exported from the HVRC VRdose Planner, including report 

elements selected by the user to configure what information should be included. It can 

therefore be used to produce report data required for producing work permit applications, 

work permits, safety cases, pre-job reports, etc. (see for example the US Department of 

Energy Radiological Control Manual for examples of information elements that should be 

included in various report types). 

Examples of information elements that can be included in a report from the HVRC VRdose 

Planner are: 

• Timeline 

• Work steps 

• Maps and routes 

• Overview of estimates for doses with charts 

• Annotations 

Other information that should be included in reports can be added (or referenced) and stored 

in the database, primarily via the annotations system, enabling practically all report elements 

recommended by the ICRP, national regulators or authorities to be included, if desired. 

3.12 Supporting Briefing 

HVRC VRdose Briefer is a dedicated presentation tool can load scenarios produced using the 

HVRC VRdose Planner. It can be used by instructors to step through animated work 

procedures and visualise radiological conditions, and can also be used for personal study. It 

is used to present scenarios “full-screen” with limited functionality in comparison with the 

HVRC VRdose Planner. 

Specifically, the HVRC VRdose Briefer can be used to: 

• Present and explain steps of work procedures 

• Highlight potential issues and hazards 

• Illustrate radiological conditions 
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A significant restriction of the HVRC VRdose Briefer is that scenarios cannot be modified 

using it, and it does not provide access to dose charts and other detailed information, 

however the HVRC VRdose Planner can, of course, also be used for briefing where more 

detailed information, complex alternatives, or “what-if” cases need to be explained. 

3.13 Supporting Execution of the Scheduled Plan 

The HVRC VRdose Planner currently supports execution of a scheduled plan in that it can be 

used to produce printouts of job plans, estimated values, dose maps, and so forth that can be 

carried by individual workers. Immediately after a job has been completed, a scenario can be 

annotated with comments and actual measured values, which can then be used for 

experience review (see below). 

3.14 Supporting Experience Review 

The HVRC VRdose Planner provides flexible support as part of the preparation of post-work 

experience review reports and visual support for debriefing.  In many ways, this activity is 

similar to pre-work briefing and reporting, but can include actual values for personal dose 

equivalents and dose-rates logged at control points during the job. To support organisational 

learning and debriefing it is useful to be able to annotate completed jobs to note and compare 

the actual durations of major work steps, expected and measured doses, and to record 

explanations for significant deviations. If a serious incident took place during the execution of 

a job then the software may be useful to help stakeholders discover the reason and to 

produce any additional data or explanations, with illustrations, required to provide genuinely 

useful information when reporting the incident. 

3.15 Supporting Organisational Learning 

Once scenarios have been prepared and the planned work has been executed, they can be 

useful for preparing case studies to teach best practices for educational purposes, and the 

radiation visualisation capabilities can be excellent for training new employees and 

contractors. Furthermore, over time, the historical data accumulated in the database can 

serve as a useful digital archive which, given sufficient amounts of data, may be useful for 

statistical analysis and other data mining activities to support organisational learning. 

3.16 Interfaces for Customisation, Integration, and 
Extension 

The software is designed to support easy extension to support new functionality, and to 

integrate into existing information architectures. While the standard system uses an 

embedded SQL database, customisation of the software is possible through custom 

development in collaboration with IFE, to bridge to alternative data sources, in particular for 

plant geometry data or historical radiological data. A Java-based plugin interface is provided 

to enable alternative radiation/dose calculators to be wrapped and integrated. An SDK for 

producing calculator plug-ins is included with the software installation and can be used 

without assistance from IFE. 
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4. Getting Started 

4.1 System Requirements 

The minimum recommended requirements for the system are: 

• Intel Core i5 x64 processor or similar 

• 6GB RAM 

• Microsoft Windows 7 64-bit or Mac OS X 10.8 Mountain Lion 

• 3D Graphics accelerator card with OpenGL 3.3 support 

• A three-button mouse (or a two-button mouse with scroll-wheel "button") 

The software can sometimes be used on a less powerful hardware however system 

performance will not be optimal. 

The recommended requirements for the system are: 

• Intel Core i7 x64 processor or similar 

• 16GB RAM 

• 64-bit Microsoft Windows 10 or macOS 10.12 

• Discrete AMD or NVIDIA 3D Graphics accelerator with OpenGL 4.2 support 

• A three-button mouse (or a two-button mouse with scroll-wheel "button") 

The software is easiest to use with a three-button mouse (including two-button mice with a 

scroll wheel "button). If used with a two-button mouse, use the alt-key on your keyboard in 

combination with the left mouse button to simulate the middle mouse button. 

4.2 Installation 

Important: See System Requirements above before installing. 

The application called "HVRC VRdose Installer" installs the HVRC VRdose software. 

Double-click on the installer and follow the instructions. 

4.3 Starting HVRC VRdose Planner 

To run the HVRC VRdose Planner, open the HVRC VRdose Planner folder, which was 

created when the software was installed, and double-click on the HVRC VRdose Planner 

application. 

Depending on which options were selected when running the installer, you may also be able 

to start the application by double-clicking on an icon on the Microsoft Windows desktop or by 

selecting it from the Start menu (in the "HVRC VRdose" group). 

The information above assumes that you are running on a Microsoft Windows platform. On 

other platforms, the installer follows the conventions of the host platform to support 

convenient execution of the software. 

Please note that the HVRC VRdose Planner software requires a license key file. The first time 

you start the HVRC VRdose Planner, it will ask you to locate the license file. If you haven’t 

received a license file please contact vrdose-support@ife.no.  
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4.4 User Interface overview 

The appearance of some user interface elements varies depending on the host operating 

system, but the general layout and functionality is the same for all platforms. 

When HVRC VRdose Planner has been started, it initially appears as shown in Figure 4.1: 

 

Figure 4.1 User Interface 

The user interface consists of a main menu bar at the top, an object catalogue to the left, the 

3D view, with toolbar, in the middle, a scenario (and work plan) overview to the right and a 

graphical scenario timeline, with toolbar, at the bottom of the user interface. An overview of 

the colour key used for the visualisation is displayed in a head-up display in the 3D view. 

After a scenario has been created or opened, the user interface typically looks like this: 
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4.4.1 Projects and scenarios 
Create new projects and scenarios, or open an existing scenario, from the 'File' menu. 

4.4.2 Adding objects 
Add objects to a scenario by dragging them in from the model bank catalogue on the left into 
the 3D view. For all projects except for the default project, a project-specific room will be 
added automatically when a new scenario is created. The first object in a scenario is always a 
(one) room. The added objects will be shown in the Scenario overview to the upper right of 
the main window. 
Not all objects in the catalogue represent physical entities. The General category contains 
objects that enable you to insert virtual dosimeters, documents, labels, or camera views into a 
scenario. 

4.4.3 Positioning objects 
Hold the Shift key to move objects and Alt-Shift to rotate objects. 

4.4.4 Producing a scenario and work plan 
Produce a scenario by adjusting the time in the scenario timeline before adding new actions. 
Adjust properties of participants and actions, and add new actions using the user interface on 
the right side of the main window. 
Actions can be grouped into descriptive steps using the Work Plan overview to the upper right 
of the main Window. The resulting work plan can be used to generate informative reports and 
to support the presentation of the scenario to stakeholders. 

4.4.5 Online Help 

Please refer to the online help found in the 'Help' menu for more details.  
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5. Reference 

5.1 Menus 
This chapter provides an overview of the main menus in the HVRC VRdose Planner. 
Keyboard shortcuts are available for the most frequently used menu actions and are 
displayed next to menu items with shortcuts. 

5.1.1 File Menu 

 

Figure 5.1 File Menu 

The File menu provides functionality for creating, opening, and saving scenarios and layouts. 
It also provides functionality for importing data into the HVRC VRdose Planner database. In 
addition, it is used to generate reports and export data, including scenarios and images to file. 

New… Create a new scenario 

Open ... Open an existing scenario or layout from the database 

Open Recent Open a recently used scenario or layout 

Save Save the current scenario to the database 

Save As... Save the current scenario with a new name to the database 

Save As Layout… Save the current scenario as a layout 

Import Scenario… Import an existing scenario from the file system 

Import Model… Import a model into the model bank 

Import Model Package Import a set of models into the model bank 

Import Dose-Rate Measurements… 

Import dose-rate measurement from the file system (XML) 

Import Dose Map… Import a dose map into the current scenario 

Export 2D Graphic… Export a snapshot of the 3d view as an image file (JPEG or PNG) 

Export Dose-Rate Grid… Export a grid of estimated dose-rates at the current scenario time 
(within the visualised bounds) to an MS Excel workbook (xlsx) 

Export Scenario… Export the current scenario to the file system 

Generate Report… Generate a report describing the current scenario (HTML) 
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Page Setup… Set the page orientation and paper size for printing the 3D view 

Print… Print the current 3D view 

Exit Exit the Planner. If you are using macOS then the Quit menu item 
is located in the application menu. 

5.1.2 Edit Menu 

 

Figure 5.2 Edit Menu 

The Edit menu is primarily used to control editing of a layout or scenario. Note that most 
editing functions in this software are provided via a drop-down menu shown when a scenario 
participant or other time is right-clicked on. 

Undo Undo last action performed in the Planner 

Redo Redo an action that has been undone 

Snap Set the snapping policy for positioning of objects. 

• None - No snapping (the default)  

• Snap to Grid - Snap to the visual grid 

• Snap to Bounding Box - Snap by aligning bounding boxes 

Snap Options… Configure snapping behaviour 

Manipulator Tools Toggle use of manipulator tools for moving and rotating objects. 

Preferences… Configure the Planner (see section 5.2). If you are using macOS 
then this menu item is located in the application menu.  

5.1.3 View Menu 

 

Figure 5.3 View Menu 
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The View menu is used to configure the user interface. The effect is global rather than stored 
in the scenario or layout. 

Background 

➢ Set Background Colour... Set the background colour for the 3D view 

Headlight Toggle headlight on and off. The headlight is a light 
attached to the view - useful for viewing dark scenes. 

Indoor Lighting Toggle indoor lighting on and off. Indoor lighting is a 
set of light designed to illuminate indoor 
environments that otherwise have no lights in the 
model. 

Timeline 

➢ Tasks    Toggle displaying tasks in the timeline 

➢ Dose graphs   Toggle displaying dose graphs in the timeline 

➢ Dose graphs 

➢ Dose-rate  Show dose-rates graphs 

➢ Accumulated dose Show accumulated dose graphs 

➢ Compact   Toggle between normal and compact display mode 

➢ Filtering    Limit type of participants to show in timeline 

Visualisation Group 

➢ Slice    Use Slice visualisation 

➢ Scalar Field   Use Scalar Field visualisation 

➢ Particle Cloud   Use Particle Cloud visualisation 

➢ Isosurface   Use Isosurface visualisation 

➢ Smooth Isosurface  Use Smooth Isosurface visualisation 

➢ View-Dependent Isosurface Use View-Dependent Isosurface visualisation 

➢ Slice – Point Cloud  Use Slice – Point Cloud visualisation 

➢ Add…    Add a new visualisation group based on current  
    visualisation options 

➢ Remove   Remove a visualisation group 

Visualisation Options   Select and configure radiation visualisation options 

Colour Map 

➢ Spectrum   Use Spectrum (rainbow) colour map 

➢ Perceptual   Use Perceptual (heat) colour map 

➢ Traffic Lights   Use Traffic Lights colour map 

➢ Configure…   Create or modify a custom colour map 

Show Colour Legend Toggle display of the Colour Legend 

Show Dose-rate Measurements Toggle display of Dose-rate Measurements in the 3D 
view 

Dose-Rate Measurements Options… Open the Dose-rate Measurements options dialog 

Wireframe Toggle Wireframe rendering of the 3D scene 

Show Grid Toggle a visual grid 

Grid Options… Configure spacing and colour of the visual grid 
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Show Selection Dimensions Toggle display of the dimensions for the currently 
selected scenario participant in the 3D view 

Show Steps Display the name or description of the current step in 
a work plan in the 3D view  

Show Annotations Toggle display of annotations in the 3D view. 

Show Information Banners Toggle display of information banners above 
participants in the 3D view. 

Show Labels Toggle labels for participants in the 3d view. If 
selected then labels set to be visible are shown. If not 
selected then labels set to visible are not shown. 

5.1.4 Camera Menu 

 

Figure 5.4 Camera Menu 

The Camera menu consists of features for aiding navigation as well as management of 
viewpoints and other camera related properties such as projection modes and field of view. 

Zoom to Selection Move the camera to fit the view to the currently selected objects  

Follow Selection When selected the camera will follow the selection. Note that normal 
camera navigation is disabled when this is menu option is selected. 

Add Viewpoint… Add a user-defined viewpoint based on the current camera view 

Delete Viewpoint Delete the currently selected user-defined viewpoint 

Viewpoints  Move the camera to a pre-defined or user-defined viewpoint in the 3D 
scene by selecting it in the sub-menu. 

Camera Mode 

➢ Perspective Set the camera to use perspective projection 

➢ Orthographic Set the camera to use orthographic projection 

Straighten  Level the camera relative to the ground plane 

Seek  Move the camera to immediately in front of a point clicked on in the 
scene after selecting this command 

Field of View…  Adjust the field of view of the camera  
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5.1.5 Scenario Menu 

 

Figure 5.5 Scenario Menu 

The Scenario menu is primarily used to control the playback of a scenario.  

Cue to Start  Cue the current scenario time to the start of the scenario 

Cue Backward Cue the current scenario time to the start of the previous action in the 
scenario. If there is more than one action at the current time, the cue 
is set to the one who ends first. 

Slow Playback  Play the scenario at half speed 

Play  Play the scenario. 

Fast Playback  Play the scenario at double speed 

Pause  Pause playback. Cue Buttons are locked. 

Stop  Stop scenario playback 

Cue Forward  Cue current scenario time to the beginning of the current action. If 
there is more than one action at the current scenario time, the cue is 
set to the one that starts first. 

Cue To End  Cue the current scenario time to the end of the scenario 

Insert Time Period… Insert a time period at the current scenario time  

Remove Time Period… Remove a time period from the scenario at the current scenario time 

5.1.6 Tools Menu 

 

Figure 5.6 Tools Menu 

The Tools menu is used to access features that support working with a scenario but do not 
modify the scenario itself. 

Dosimeter Tool Toggle the Dosimeter Tool, which enables you to click on a surface in 
the 3D scene to look up the dose-rate at the clicked point 

Compare Scenarios… Compare the vital statistics about the current scenario with other 
scenarios 

Grid Control Display a dialog to control the grid orientation and position 
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5.1.7 Windows Menu 

 

Figure 5.7 Windows Menu 

The Window menu gives access to secondary windows that can be used to view information 
about a scenario and to perform scenario-specific configurations and analyses. 

Annotation Manager Open the Annotation Manager, which is used to edit or add 
annotations about the current scenario. The annotations are used for 
information purposes and to add documentation that is output when 
reports are generated. 

Radiation Calculator Open the Radiation Calculator configuration window, which is used to 
select  and configure the calculator to use to calculate doses. 

Dose-Rate Analyser Open the Dose-Rate Analyser, which is used to displays dose charts 
in a secondary window. 

Radiation Analyser Open the Radiation Analyser, which is to display a breakdown of the 
contributors to a dose 

Room Configuration Open the Room Configuration, which is used to toggle visibility of 
named components (if any) in the geometry hierarchy of the Room 
model. 

5.1.8 Help Menu 

 

Figure 5.8 Help Menu 

The Help menu provides access to copyright information about this software and to online 
help.  

About… Display system, copyright, and licensing information about this 
software. If you are using macOS then this menu item is located in 
the application menu. 

Startup Tips Display the Startup Tips dialogue 

Check for Update Check if a newer version of the software is available 

Help  Access the online user guide 
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5.2 Configuring User Preferences 
This section describes the options available in the User Preferences dialog. These enable 
fine-tuning of the user experience and 3D rendering. 

 

 

Figure 5.9 The Preferences Window 

You can adjust your personal configuration via the options in the Preferences Window. 

The Preferences Window can be accessed from the main menu bar's Edit > Preferences… 

menu item (or in the Application menu on macOS). The keyboard shortcut to open the 

Preferences Window is ctrl-comma (or command-comma). 

Changes to preferences are global and therefore affect all your work with the HVRC VRdose 

Planner, however they are also personal and will not affect any other users of software that 

share a computer as long as you are not sharing a computer user account. 

There are three sets of preferences in the Preferences Window. The individual sets and the 

options they contain are described in the subsections below. 

The Preferences Window has three buttons: 

• OK is used to update the preferences and close the window 

• Apply is used to set the update the preferences but not close the window 

• Cancel is used to dismiss the window without making any changes 

Clicking Apply followed by Cancel is equivalent to clicking OK. 

A configuration file containing your preferences is created in your home directory and will be 

applied the next time you run the software. 

Closing the window by clicking on the close box (top right of the window) or hitting the escape 

key is equivalent to clicking on the Cancel button. 
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5.2.1 General Preferences 

 

Figure 5.10 The General Preferences section of the Preferences Window 

The General Preferences section of the Preference Window is used to overall preferences for 

the user interface. 

The General options are described below: 

Appearance The default Appearance is that of the host operating 

system. The host operating system appearance normally 

gives the software a look similar to that of other applications 

on your computer. The cross-platform setting provides a 

consistent user interface look and feel regardless of 

whether you are running the software on Windows, Linux, 

macOS, or some other operating system. 

Language The text of the user interface can be displayed in may be 

English, US English, Norwegian, or Russian. By default this 

option is set to system default, enabling the software to 

select the language automatically depending on your 

operating system language settings. However, you can also 

select the language specifically. For example, this can be 

useful if you are working on an international project where 

English is the project language, but your personal computer 

is otherwise configured to use a non-English language. 

Other language options may be offered in future. 

Metric distances If you want distances to be displayed using U.S. 

measurement units then you can turn this option off, 

otherwise distances are displayed in metric units. 

Note that this changing this option is not permitted in 

version 2.0. 
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5.2.2 3D View Preferences 

 

Figure 5.11 The 3D View Preferences section of the Preferences Window 

The 3D View Preferences offer control over the way in which the 3D graphics are rendered. 

These options generally have no effect until the application has been restarted as they affect 

the way in which the 3D view is initialised. 

The 3D View options are described below: 

Enable texture mip-mapping Enable generation of multi-resolution textures when 

textured models are loaded. This option improves the 

appearance and performance of textures, however some 

graphics cards may not support this feature and the loading 

of textured models may be significantly slower if this option 

is enabled.  

Enable implicit anti-aliasing Allow the display driver to control full-screen anti-aliasing 

settings. If you have a graphics card with support for anti-

aliased rendering then this option enables will cause the 

tool to acknowledge your anti-aliasing set-up. This option 

can greatly improve the visual appearance of the 3D view 

but there may be a significant performance loss, and some 

graphics cards do not support this feature.  

Enable stereoscopic rendering Enable initialisation of 3D views in stereo mode. This option 

will only have an effect if you have a graphics card that 

supports active stereoscopic rendering. Unless you are 

actually using stereoscopic hardware, you should not 

enable this option as stereoscopic rendering will decrease 

the overall performance of the 3D view as it requires more 

effort of the graphics card. Default off. 

Enable render lock Controls rendering execution. Try changing this if you have 

driver problems. In general, you should leave it off. This 

option is offered only because it can resolve graphics driver 

problems in some special cases. Default off. 
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Optimize for space Optimize 3D geometry to use less memory at the expense 

of slower performance. Only disable this if you have lots of 

memory and need to squeeze out a little more performance. 

In most cases the difference is hard to detect so we 

recommend leaving it on. Default on. 

5.2.3 Input Configuration 

 

Figure 5.12 The Input Configuration section of the Preferences Window 

The Input Configuration options allow you to set the default speed to use when new 

participants are added to a scenario, and whether new participants should be automatically 

rotated to face the view when added. 

The Input Configuration options are described below. 

Manikin walk speed Default walking speed in m/s for new manikins.  

Object move speed Default movement speed in m/s for new objects. 

Auto-rotate objects Option to automatically rotate objects added so that they 

face the current view. If this is not selected then objects are 

placed with their default rotation relative to the global origin 

of the 3D scene. 
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5.2.4 Expert Preferences 

 

Figure 5.13 The Expert Preferences section of the Preferences Window 

The Expert preferences provide access to additional options, described below: 

Automatic version check Turn off the automatic daily checking for a new release of 

the software. If you turn this off then you will not be 

informed automatically of new updates, but can still check 

for updates manually via the Help-menu (Help > Check for 

Update). Default on. 

Watermark exported 2D graphics If this option is enabled then "HVRC VRdose Planner" and 

the name of the licensee is inserted at the top left on 

exported images. In the demo version then this cannot be 

turned off. Default off. 

Detailed technical log in About box Select to enable detailed technical logging of system 

behaviour in the log in the About box. This is useful for 

troubleshooting if you experiencing technical issues with 

the software, and you need to contact support for 

assistance. Enabling this option has a small negative 

effect on the system performance. Default off. 

Enable experimental 3D loaders Select this to enable experimental 3D loaders, to support 

importing 3D models in LWO, OBJ, PLY, and SCENE 

(Ogre3D) formats. Default off. 

3D View Clip plane distances If you experience tearing effects in the 3D view then this 

may be because your graphics processor is unable to 

draw surfaces with sufficient precision. The near (front) 

and far (back) clip planes (and the field of view) specify 

the camera view frustum that is rendered. To increase 

rendering precision, try increasing the front clip distance 

and/or decreasing the back clip distance. 
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5.3 Preparing 3D Models 

This section provides guidance on producing 3D models for use in the HVRC VRdose 

Planner. The Model Bank database supports version control for individual objects, as well as 

alternative "room" versions to enable variations of a room model to be selected by date. 

5.3.1 File format 

The internal file format used for 3D models in the Model Bank is ISO VRML97 (Virtual Reality 

Modelling Language). VRML files can be exported from most high-end CAD and 3D modelling 

packages, including the free 3D modelling tool Blender. Details about ISO VRML97 can be 

found on the Web 3D Consortium website: http://www.web3d.org/. VRML units are metres. 

You can also import models stored in the increasingly popular COLLADA (DAE – Digital 

Asset Exchange) and KMZ formats. Many CAD and 3D modelling packages can export data 

in these formats, including Trimble SketchUp. Most online 3D model archives offer models in 

at least one of these three supported formats. Additional "experimental 3D loaders" (ie not 

guaranteed to always work) can be enabled in the User Preferences for the HVRC VRdose 

Planner. The experimental loaders include LWO, OBJ, PLY, and SCENE (Ogre3D) formats. 

If you are producing or converting models yourself then it is useful to be aware of the 3D 

modelling practices that can make your model more efficient and trigger special features in 

the HVRC VRdose Planner. Please contact technical support for advice on conversion from 

specific formats as we can give guidance on free or commercial tools for conversion and on 

the best intermediate formats to use to exchange data. 

Regardless of the format used to transfer a 3D model into the Model Bank, the same basic 

rules apply in order to produce models that are optimised for use in the HVRC VRdose 

Planner. These are described in the following sections. 

5.3.2 The origin and centre of rotation 

When a model is dropped on a surface in the HVRC VRdose Planner, the origin is the point 

where the model will initially be attached to the surface. When that model is rotated then it is 

by default rotated around the Y-axis around the origin. Using an appropriate origin is therefore 

important. For example, a model of a chair would normally have its origin at floor level with 

the Y-axis passing through the centre of the model. 

  

Figure 5.14 Centre of rotation OK 

  

Figure 5.15 Centre of rotation not OK 

http://www.web3d.org/
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Above are two pictures of the same model. In the first picture, the model's centre of rotation is 

correct, while in the second picture, the centre of rotation represents an example of a location 

that would be difficult to work with interactively as the object will be positioned and rotated 

relative to that position when the user moves the object in the HVRC VRdose Planner. 

For objects that will be attached to walls and ceilings then the model’s Y-axis should be 

defined as if the object were to be placed flat on the floor. This ensures that the correct 

orientation is obtained when the object is placed on a wall or the ceiling. For example, a wall 

sign should be modelled with the front face facing up and a ceiling lamp should be modelled 

upside down. To see examples, have a look at existing objects in the Model Bank that are 

intended to be placed on walls or the ceiling. 

In special cases you may want the origin to be somewhere other than the middle of the base 

of the model, but this is rare for typical HVRC VRdose Planner use-cases.  

5.3.3 Orientation 

Models should be produced so that they are flat in the XZ-plane and with orientation around 

the Y-axis set to neutral (0). When a HVRC VRdose Planner user rotates an object 

interactively, it is rotated around the y-axis of the model relative to the centre of rotation 

(origin) of the object, relative to the surface on which the object is placed, although the user 

can opt to rotate an object freely by turning on Manipulator Tools in the Edit menu. 

Below are two pictures of the same model of a chair. In the first picture, the model's 

orientation is correct (with the legs on the group plane, which is the XZ-plane), while the 

orientation of the chair in the second image is, of course, inappropriate. When you load a 

model into the HVRC VRdose Planner then it should normally face the user, if it is an object 

that is placed on the floor, e.g. a chair or a shelving unit that stands on the floor. While there 

is no harm in such units being oriented differently around the Y-axis, since the Y-rotation can 

be modified in the HVRC VRdose Planner, it is easier for the end-user if the initial direction 

that objects face in is consistent. 

  

Figure 5.16 Orientation OK 

 

Figure 5.17 Orientation not OK 

5.3.4 Lights 

3D models representing lights can be used for "light" models and are permitted to contain 3D 

lights that cast light. All other models that would not naturally cast light should not contain 

lights. Room models may contain lights. But that is not required as the HVRC VRdose 
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Planner provides a general 'indoor lighting' option which is normally preferable. 3D models 

added to the Model Bank can have realistic lighting effects baked into their textures, however 

these will, of course, not affect other models added to a layout. A baked room can be very 

effective for showcasing a plan (e.g. for training or briefing) but takes more time to prepare. 

5.3.5 Inline files 

A 3D model file (VRML97, DAE, KMZ) imported into the Model Bank may contain internal 

references to other 3D data files, image files for textures, and other resources. If the 

referenced files are not in the same directory (or a sub-directory) as the main model file, the 

HVRC VRdose Planner will attempt to copy them and reorganise the file structure of copy of 

the model that will be added to the database, so the resulting model in the Model Bank is 

guaranteed to be complete. 

5.3.6 Textures 

Textures should follow usual conventions for 3D models intended for interactive applications. 

Textures should not be larger than necessary to conserve texture memory -- it is rarely 

necessary for textures to be larger than 1024x1024 in size, and it is generally good practice to 

provide images using powers of 2 (i.e. 4x4, 8x8, 16x16, 32x32, etc.) pixel dimensions for 

optimal performance. Most graphics cards do not support textures larger than 4096 x 4096 at 

all. 

We recommend using PNG-format for textures to avoid compression artefacts, although for 

photographic-type images, JPEG may give adequate results with smaller file sizes. PNG is 

preferable to GIF when using transparency as it supports finer control of transparency levels. 

The colour of surfaces and the textures are blended, so you should normally use white 

materials “under your textures” if you want the texture’s own colour to dominate. 

5.3.7 Supported features 

Only static geometry is supported. Animations, scripted, or interactive features are generally 

ignored. 

5.3.8 Creating manikins 

Manikins are modelled using the ISO/IEC FCD 19774 H-ANIM 1.x standard, however the 

current version of the HVRC VRdose Planner does not provide tools for end-users to import 

manikins.  

IFE can supply or convert custom-specified manikins, Please contact HVRC VRdose Support 

for assistance. When new manikin models are prepared by IFE then they are supplied in the 

form of a Model Package that can be imported into the HVRC VRdose Planner by an end 

user. 

5.3.9 Creating rooms 

Rooms can be modelled in the HVRC VRdose Planner itself (using primitive shapes or shield 

objects from the object Catalogue) or in a 3D modelling package for inclusion in the Model 

Bank. This section concerns rooms created in a 3D modelling tool that will be added to a 

Model Bank. 
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Rooms can be modelled in a way that makes it possible to hide and show parts of the room to 

make viewing and editing easier. In most cases, at least the ceiling should be identified to 

enable the user to hide it and more easily access the contents of the room. 

To make part of a room identifiable, that part (node) has to be named in the model data. Note 

that when part of a room is hidden or shown, any children of that part will also be toggled. The 

model should therefore be structured appropriately. 

VRML97 Example: 

#VRML V2.0 utf8 

DEF Room Group { 

  children [ 

    DEF Floor   Transform { … } 

    DEF Ceiling Transform { … } 

    DEF Walls   Transform { … } 

    …   

  ] 

} # end of Room 

Note that …in this example indicates additional code.  
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5.4 System Administration 

This section provides guidance on administration of the software by system administrators or 

advanced users. 

5.4.1 Customising installation 

The HVRC VRdose Planner by default stores all its data and settings in a folder named 

'.haldenvr' under your user profile - e.g. ‘C:\Users\<username>\.haldenvr’ on a Windows 

computer. Under macOS, the data located in ‘.haldenvr” in the user’s home folder, while the 

settings are  located in ~/Library/Preferences/haldenvr. 

The first time you start the HVRC VRdose Planner you will be asked if you wish to store data 

in an alternative location. 

If you need to move your data to a new location after the first run: 

1. Ensure that the HVRC VRdose Planner is not running. 

2. Copy the ‘haldenvr_data’ directory to the new location. 

3. Locate the settings file ‘haldenvr.properties’. 

4. Open ‘haldenvr.properties’ in a text editor. 

5. Search for the property ‘'hvrc.data' and adjust the specified location accordingly. 

5.4.2 Backing up data 

It is strongly recommended that the data directory is regularly backed-up to reduce the risk of 

data loss. 

In order to back up or move data to another computer or disk, you can simply copy the data 

folder (‘haldenvr_data’) from the location described above under Customising installation. 

5.4.3 Installing software updates 

The software installer supplied can be used both to install a new copy of the software and to 

update an existing one. If you run the installer on a system with an older version installed 

previously then any existing settings and data are kept. 

Uninstalling the HVRC VRdose Planner will not delete the settings and data.  



HVRC VRdose Planner SUM Issue 2 Revision 1 (4 November 2020) 
Software User Manual 

 

- 39 - 

5.5 Dosimetric Models 

5.5.1 Advantages of Real-Time Dosimetric Models 

HVRC VRdose Planner is based on a highly optimized dosimetric package, especially 

designed to enable reasonably accurate real-time 3D dosimetric computation using a well-

documented point-kernel approach. 

• Real-time response enables very efficient optimization of work strategies, by 

facilitating users to rapidly explore and compare alternative scenarios (e.g. biological 

shielding configurations). 

• We can simulate radiation risk assessment in dynamically changing environments, 

where the radiation situation is dynamically altered by changes to radiation sources 

and biological shields. While useful for planning non-routine activities during the 

operational phase of a nuclear facility, it is especially useful during the 

decommissioning phase where the environment is continuously changing. 

• Real-time risk assessment can be used during a radiological accident situation to 

support decision-making in a stressful situation. 

• During training or briefing, the consequences of actions can be demonstrated in real-

time. 

While non-real time tools can provide a high level of accuracy in theory, we believe that real-

time tools are more suitable for the tasks listed above. To achieve real-time capabilities, great 

demands are made for the performance of the radiation transport techniques applied, limiting 

the options to those techniques capable of high-speed calculation while still yielding reliable 

results. This requirement effectively rules out sophisticated radiation transport models such as 

those based on precise Monte-Carlo techniques, but is also demanding for deterministic 

radiation transport techniques. 

5.5.2 Flexibility and Extensibility 

It is not always possible or advisable to use a point-kernel based radiation transport model, so 

you need to bear in mind the following points: 

• Radiation transport simulation requires adequate knowledge about the radiation 

sources in a scene. In situations where such data is missing, radiation risk 

assessment is still possible, if suitable scattered data (a set of dose measurements) 

are available. 

• Deterministic radiation transport techniques become increasingly unreliable for 

calculating dose with increasing contribution of scattered radiation. In such situations 

measurements, quantifying the contribution of multiply scattered photons, can be 

taken into account in addition to the radiation transport calculations. 

• There are additional efficient dosimetric methodologies that can be applied in 

transitional situations, where some knowledge about the radiation sources is 

available in addition to measurements. 

Therefore, in addition to radiation transport techniques, the software also supports the use of 

other dosimetric models, based on interpolation and other techniques, in order to be able to 

adapt the software to using the best radiological input data available. HVRC VRdose Planner 

includes an open programming interface that can be used to develop plugin-in software 

modules to integrate additional dosimetric models into the system. It can also import sets of 



HVRC VRdose Planner SUM Issue 2 Revision 1 (4 November 2020) 
Software User Manual 

 

- 40 - 

dose-maps produced entirely independently using other software, in addition to dose-rate 

measurements registered in the field. 

5.5.3 Further Reading 
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6. Appendix 

6.1 Glossary 

Action In the context of a scenario, an activity that a participant can perform, such 

as moving, waiting, working, and so forth. 

Administrator The user that is responsible for the management of the software 

installation.  

COLLADA  See DAE. 

DAE   Digital Asset Exchange; an ISO-standard file format for exchange of digital 

assets, including 3D models between software systems (ISO/PAS 

17506:2012). 

Developer A programmer using the software to implement extensions to it 

GPU Graphics Processing Unit. A dedicated processor that is highly efficient 

and manipulating graphics and images. Usually employ a highly parallel 

architecture that can also support the execution of general-purpose 

parallel computing algorithms. 

VRdose Planner 3D job planning tool with radiation visualisation and dose estimation. 

HTML   Hypertext Mark-up Language. 

HVRC  Halden Virtual Reality Centre – IFE’s VR research centre in Halden. 

IFE     Institute for Energy Technology (Institutt for energiteknikk). A research 

foundation in Norway located at Kjeller and Halden. 

Instructor A user that is using the software for teaching or briefing purposes. 

JPEG   An image format with lossy compression. 

Layout A static representation of the virtual radiological environment that 

represents a snapshot at a specific time that can be used as a reference 

scene configuration for new scenarios. 

Manikin A virtual human. A 3D model of a human used to simulate and evaluate 

jobs. Usually represents a worker. 

Model Bank a hierarchically organised model database that supports the storage and 

access to 3D models with meta-data and version control of models 

Participant An object in a scene that can perform actions, thus participating in a 

scenario. 

PNG An image format that supports efficient lossless compression. 

Project A collection of related scenarios and layouts, with additional common 

project meta-data (expected start date, expected end date, description, 

and references.) 

Room The virtual environment in which a scenario takes place. It is typically 

represented as a single static 3d model representing a building. While 

static within the scope of a single scenario, there may be multiple variants 
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of a room model representing the (planned or actual) state of the building 

at specific dates/times. 

Scenario A collection of participants that perform actions over time in a virtual 

radiological environment. A scenario always has a specified start and end 

date. 

Scene The view of a layout displayed in a 3D view, comprising of a hierarchy of 

participants in a room. 

SDK Software development kit. A code framework for extending the 

functionality of the software system. 

SQL Structured Query Language; A standard language for querying relational 

databases. 

UI User interface. 

User The end-user of the software system. 

XML Extensible Mark-up Language; A set of rules for encoding arbitrary data 

and documents in a machine-readable form. 

VR Virtual reality. Interactive 3D visualisation, ideally displayed full-scale. 

VRML Virtual Reality Modeling Language. VRML 97 is an ISO standard 3D file 

format (ISO/IEC 14772-1:1997). 
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6.2 File Formats 

6.2.1 Dose-rate measurement data 

6.2.1.1 Description 

A measurements file is used to import measurements into HVRC VRdose Planner from data 

logging systems. The contents of a measurements data file are formatted using XML and are 

otherwise text files that can be read and edited using a text editor and are thus easy to 

produce. 

A measurements data file contains a measurements element enclosing 0 or more 

measurement elements. 

6.2.1.2 Example File 

<measurements> 

  <measurement> 

    <date>2011-10-24T15:29:42</date> 

    <position>0 2 2</position> 

    <doseRate>10</doseRate> 

    <unit>mSv/h</unit> 

  </measurement> 

  <measurement> 

    <date>2011-10-24T15:29:30</date> 

    <position>0 2 -2</position> 

    <doseRate>1</doseRate> 

    <unit>mSv/h</unit> 

  </measurement> 

</measurements> 

6.2.1.3 <measurements> Element 

Syntax  

<measurements> 

  <!-- 0 or more measurement elements --> 

</measurements> 

Description 

An encapsulation element for grouping a set of measurement nodes. 

6.2.1.4 <measurement> Element 

Syntax 

<measurement> 

  <!-- dateTime --> 

  <date>...</date> 

  <!-- 3 space separated floats --> 

  <position>...</position> 

  <!-- float --> 

  <doseRate>...</doseRate> 

  <!-- string --> 

  <unit>...</unit> 

</measurement> 
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Description 

Defines a single measurement node encapsulating the following data elements: date, 

position, doseRate, and unit. 

<date> The date and time of the measurement. The dateTime is defined 

according to XML Schema and can be expressed as 

 yyyy-mm-ddThh:mm:ss[Z|(+|-)hh:mm] 

<position> Where the measurement was taken in the coordinate system of the room 

in metres (e.g. 0 0 0, if at the origin of the coordinate system) 

<doseRate> The value of the measurement (e.g. 0.1) 

<unit> The unit of the measurement (e.g. mSv/h, nR/s, pGy/y). The unit can be 

expressed as [scale]Symbol/rate. Scale must be one of m (milli), mu 

(micro), n (nano) or p (peta). The scale can be omitted, in which case 1 is 

used. Symbol can be any string, except it cannot have the same prefix as 

any of the predefined scale values. The rate specifies the time and must 

be one of y (year), h (hour) or s (second). 

6.2.2 Dose map data 

6.2.2.1 Description 

A dose map file is used to import dose map data into HVRC VRdose Planner. The file 

contains a set of time-specified snapshots, enabling for the dose map to change over time. A 

right-handed coordinate system is used where the y-axis is up. 

6.2.2.2 Example File 
<dosemap> 

  <unit>mSv/h</unit> 

  <snapshot> 

    <date>2012-02-15T10:30:15</date> 

    <grid> 

      <lower>-10.0 0.0 -10.0</lower> 

      <upper>10.0 2.0 10.0</upper> 

      <elements>3 2 3</elements> 

    </grid> 

    <data>0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17</data> 

  </snapshot> 

  <snapshot> 

    <date>2012-02-15T10:31:00</date> 

    <grid> 

      <lower>-10.0 0.0 -10.0</lower> 

      <upper>10.0 2.0 10.0</upper> 

      <elements>3 2 3</elements> 

    </grid> 

    <data>10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27</data> 

  </snapshot> 

</dosemap> 

6.2.2.3 <dosemap> Element 

Syntax  

< dosemap> 

  <!-- string --> 

  <unit>...</unit> 

   

  <!-- 0 or more snapshot elements --> 

</dosemap> 
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Description 

Contains a list of snapshot elements at specific times in the scenario. All values in all 

snapshots must use the same unit specified by the unit element. 

6.2.2.4 <unit> Element 

Syntax 

<unit>...</unit> 

Description 

The unit of the dose-rate values in the grid of data in the snapshots (e.g. mSv/h). 
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6.2.2.5 <snapshot> Element 

Syntax 

<snapshot> 

  <!-- dateTime --> 

  <date>...</date> 

  <grid> 

    <!--  floats (x y z) --> 

    <lower>...</lower> 

    <!-- floats (x y z) --> 

    <upper>...</upper> 

    <!-- integers (x y z) --> 

    <elements>...</elements> 

  </grid> 

  <!-- x y z floats --> 

  <data>...</data> 

</snapshot> 

Description 

Defines a regular grid of dose-rate values for a specific time. 

<date> The date and time of the measurement. The date and time (dateTime) is 

defined according to XML Schema and can be expressed as 

 yyyy-mm-ddThh:mm:ss[Z|(+|-)hh:mm] 

<grid>  Defines the number of sample points in the grid and the position of each 

point. The lower element specifies the position of the point with the lowest 

x, y and z values. The upper element specifies the position of the point 

with highest x, y and z values. The elements element specifies the 

dimensions of the grid, being the number of sample points in each 

direction (e.g. 2 2 2 for a grid comprising of eight points and one cell). 

<data> The dose-rate values of the grid. The number of values is given by the 

grids elements x*y*z. There have to be one space between each value. 

<unit> The unit of the measurement (e.g. mSv/h, nR/s, pGy/y). The unit can be 

expressed as [scale]Symbol/rate. Scale must be one of m (milli), mu 

(micro), n (nano) or p (peta). The scale can be omitted, in which case 1 is 

used. Symbol can be any string, except it cannot have the same prefix as 

any of the predefined scale values. The rate specifies the time and must 

be one of y (year), h (hour) or s (second). 

Code to generate a position for each value for the grid can be written as follows: 

for (int zIdx = 0; zIdx < elements.x; zIdx++) { 

  for (int yIdx = 0; yIdx < elements.y; yIdx++) { 

    for (int xIdx = 0; xIdx < elements.z; xIdx++) { 

      float x = lower.x + (xIdx / (elements.x - 1f)) * (upper.x - lower.x); 

      float y = lower.y + (yIdx / (elements.y - 1f)) * (upper.y - lower.y); 

      float z = lower.z + (zIdx / (elements.z - 1f)) * (upper.z - lower.z); 

    } 

  } 

} 
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